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Project Monitoring system 
 

1.1 Project Monitoring System is a Online Web Based Computer 

application used for Monitoring the progress of different activities of 

Construction Projects from Planning to Execution stage.   

1.2 Purpose :- following four main purpose are :-  

1. Preparation of Online Monthly Progress report of all projects. 

2. Online Monitoring of progress of all projects including their 

packages and all Agreements drawn for a project, in 

planning as well as in execution stage online by different 

level of officers.  

3. Generation of Online Mandatory letters at important stage of 

work. This is required for automatic updating of data related 

to project required in MPR. 

4. Monthly Progress Report can be viewed by all officers and client as 

well. 

 

1.3 Requirements of Project Monitoring System 

 

This programme work in two phase :- 

 

1. Online WBPMS :- Details of all Project / package / Subwork 

and all data are to be stored in a database ( presently maintained by 

NIC Server at New Delhi. Project Registration, updation of data, 

printing of online generated letters, progress update and progress 

monitoring is to be done online. 

2. Divisional Accounting package :- To be maintained on 

desktop computer of each division where expenditure figures are to be 

updated.  

Mapping of project ID of WBPMS with data of 
Divisional accounting package :- A 8 digit code is generated 

against each subwork/Agreement in Divisional accounting package. This 8 digit 
code generated in divisional accounting package is to be entered in WBPMS 
against the SubWork/ Agreement of respective project for linking/ Mapping. 
Expenditure is to be booked against each Subwork/ Agreement for which a 
separate T/S has been issued. After linking Expenditure figure shall be picked up 
by WBPMS for each Project Agreement wise from different divisions database.  
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1.4 Project - package  - Agreement (called 

subwork before award). 

 

Each AA and ES has to be considered as a seperate 

project  
 

A project is a work for which a separate AA & ES is to be or 

has been issued. A project may have either a single 

agreement or it may be executed through several 

agreements. In Web based Project Monitoring system a 

Project should be divided as follows :- 

Example for illustration :-  

 

1. Project 1 ( Name of Project for which a separate AA & ES 

has been issued) 

a. Package 1 ( to be decided by project Owner) 

i. Agreement 1 ( it may be civil/Elect/hort work)  

ii. Agreement 2  (it may be civil/Elect/hort work) 

iii. Agreement 3 ( it may be civil/Elect/hort work) 

b. Package 2 

i. Agreement 4 (it may be civil/Elect/hort work) 

ii. Agreement 5 (it may be civil/Elect/hort work) 

 

Registration of Project and Decision of division of project into 

package and agreement is to be done by project owner.   

 

Subwork is a part of a package which has to be further 

converted into an agreement by call of tenders. 
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Example of a JNV Project :- 

  AA and ES 
amount 

Agreement 
amount 

Remarks 
 

1 Name of Project :-  

C/O Javahar Navodaya 
Vidyalay at Pune. 

Rs 1200 
Lakhs 

 Shall be registered  by 
Project owner 

 Package 1 School Building 700 lakhs  Package division shall be 
made by project owner. 

Civil 
Div 
work 

Agreement 1 ( or Subwork 1) 
C/O School Building for JNV 
at Pune (Civil Works) 

 
600 Lakhs 

 
586Lakhs 

1. Each agreement is 

called sub-work before 

award of work. 

2. Decision of Sub-works 

is to be done by project 

owner. 

3. Subwork /Agreement 

registration shall be 

made within a project 

by project owner and 

all activities of subwork 

can now be monitored 

by different offices. 

4. Separate T/S shall be 

issued for each 

agreement/ subwork. 

5. Separate tenders shall 

be called for each 

subwork and shall be 

converted into 

agreements  

6. All Expenditure has to 

be booked agreement 

wise for exact 

preparation of Monthly 

account and Monthly 

progress report. 

7. Any new agreement 

can be added at later 

stage also by project 

owner. 

Civil 
Div 
work 

Agreement 2 
C/O Water Tank for School 
Building for JNV at Pune 
(Civil Works) 

 
50 Lakhs 

 
57 Lakhs 

Elect  
Div 
work 

Agreement 3 
C/O Street lighting for road 
outside  School Building for 
JNV at Pune (Electrical 
Works) 

 
30 Lakhs 

 
32 Lakhs 

Hort 
div 
work 

Agreement 4  
Horticulture works for School 
building for JNV at Pune  
( Horticulture work) 

 
20 Lakhs 

 
23 Lakhs 

    
 Package 2 Staff 

Residences 
500 lakhs  

Civil 
div 
work 

Agreement 1 
C/O Staff Residences for 
JNV at Pune (Civil Works) 

 
400 Lakhs 

 
412 Lakhs 

Civil 
div 
work 

Agreement 2 
C/O Road work for Staff 
Residence for JNV at Pune 
(Civil Works) 

 
50 Lakhs 

 
42 Lakhs 

Elect 
div 
work 

Agreement 3 
Electrical works for Staff 
Residence for JNV at Pune 
(Electrical  Works) 

 
30 Lakhs 

 
33 Lakhs 
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1.5 Different Activities to be monitored for a project :-  

 1. Planning Stage Activities :-  For Each Projects  

( Activities from 1 to 7a is to be monitored project wise) :- 
Sr 
NO 
 

Activities Action required by 
Authority in CPWD 

Action required in WBPMS 

1 Registration of Project on 
receipt of requisition 
letter from client.  

Project Owner  Print Project registration letter (Get 
format letter No. 1) 

2 Preparation and sending 
of Preliminary 
Architectural Drawing to 
client 

Architect office  
Senior Architect/ 
Architect 

 

Get format letter No. 2  

3 Approval of Architectural 
Drawing from Client. 

Client Department  / 
Senior Architect 
 

Get format letter No. 3  
after getting approval of 
architectural drawing and send to 
all offices concerned. 

4 Approval of Plan from 
other Government 
bodies as per 
requirement for different 
type of project based on 
its cost, location, use etc. 

Like DUAC, AAI, 
ASI, Fire, Traffic, 
Pollution etc  

No action in WBPMS 
 
Not yet considered in WBPMS ( 
Later it shall be incorporated) 

5 Approval of Architectural 
Drawings from Local 
Bodies. 

Local Bodies like 
MCD, NDMC, DDA 
etc. 

No action in WBPMS 
 
Not yet considered in WBPMS ( 
Later it shall be incorporated) 
 

6 Preparation of and 
sending of Preliminary 
Estimate to client 
department  

Planning head 
attached with Project 
Owner 
SE(P)/ EE(P)/ AE(P) 
 

Get format letter No. 4 from 
WBPMS ( forwarding letter of 
Preliminary Estimate) 

7 Issue of A/A & E/S by 
Client department and 
release of Fund. 

Client deptt/ 
Planning head 
attached with Project 
Owner 
SE(P)/ EE(P)/ AE(P) 
 

Get format letter No. 5 from 
WBPMS ( Convey approval of AA 
and ES to other offices including 
decision of package and subworks) 

7 a Division of Package and 
Subworks by Project 
Owner 

Project Owner Decision of Sub-works is to be 
done by project owner. 
Subwork /Agreement registration 
shall be made within a project by 
project owner and all activities of 
subwork can now be monitored by 
different offices. 
New agreement can be added at 
later stage also by project owner 
adding with some package. 
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 2. Planning stage activities for Each Sub Works/ 
Agreements  
( Activities from 8 to 18 is to be monitored Sub Work or Agreement wise) 
 

Sr 
NO 
 

Activities Action required by 
Authority in CPWD 

Action required in WBPMS 

8 Issue of Detailed 
Working Architectural 
Drawings. 

Architect office 
 

Get format letter No. 6 of WBPMS 

9 Issue of Structural 
Drawings 

Structural design 
unit.   
(SE(P)/EE(P)/ AE(P) 
unit 
 

Get format letter No. 7 of WBMS 

11 Preparation of Detailed 
Estimate and Issue of 
Technical Sanction  

Planning head 
attached with Project 
Owner 

Get format letter No. 8 of WBPMS 

12 Issue NIT for call of 
tender of each Subwork. 

Planning head 
attached with Project 
Owner 

Get format letter No. 9 of WBPMS  

13 Call of Tender and 
sending to Press and 
Internet media for wide 
publicity as per 
requirement. 

Executive Engineer 
of Field unit. 

Get format letter No. 10 of WBPMS  

14 Sale of tender papers 
and Receipt of Tenders. 

Executive Engineer 
of Field unit. 

No Action required in WBPMS.  

15 Scrutiny of Tender and 
sending to competent 
authority for approval of 
tender. 

Executive Engineer 
of Field unit. 

Get format letter No. 11/12/13  
 
( letter No. 11 for EE to SE) 
( letter No. 12 for SE to CE) 
(letter No. 13 for CE to higher 
office) 

16 Acceptance of Tender by 
Competent Authority. 

Competent authority 
As per CPWD 
Manual 

No action.  
Tender approval has to be 
conveyed only in hard copy.   

17 Issue of Letter of 
acceptance to 
Construction agency for 
submitting the 
Performance guarantee. 

Executive Engineer 
of Field unit. 

Get format letter No. 14 of WBPMS 

18 Final Award of work after 
submitting the 
performance guarantee.  
 
 

Executive Engineer 
of Field unit.  

Get format letter No. 15 of WBPMS 
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 3. Execution Stage Activities For Each Sub Works/ 
Agreements :- 
(Activities from 19 to 25 is to be monitored Sub Work or 
Agreement wise) :- 

Sr 
NO 
 

Activities Action 
required by 
Authority in 
CPWD 

Action required in 
WBPMS 

19 Timely Issue of Remaining 
Architectural and Structural 
drawings, if all drawings are not 
issued before start of work. 
 

Architect 
Unit and 
Structural 
Design unit  

Use format letter No 6 or 
7 for issue of drawing 

20 Updating the Expenditure 
Figure every month by linking 
with Divisional accounting 
Package 

ALL Field 
unit 
(Division 
offices 
maintaining 
account ) 

To be done once in a 
month after updating the 
Expenditure figure of 
Divisional accounting 
package. 

21 Updating the percent progress / 
Target date of completion and 
Remarks of each agreements in 
Execution stage 
 

EE field unit To be done once in a 
month after updating the 
Expenditure figure of 
Divisional accounting 
package. 

22 Updating the remarks by higher 
officers 

SE/ CE To be done online after 
updating data by  
Executive Engineer 
office. 

23 Monitoring of Milestones of 
different agreements 

EE Field 
unit 

Not yet included in 
WBPMS ( Shall be taken 
up in 2nd Stage) 

24 Monitoring of Extra Items / 
Subsititute Items / deviation etc 
to be sanctioned with an 
agreements  

Executive 
Engineer 
Field unit 

Not yet included in 
WBPMS( Shall be taken 
up in 2nd Stage) 

26 Completion of project, Record 
of Completion Certificate and 
sending information to client for 
taking over the building 
 

Executive 
Engineer 
Field unit 

Not yet included in 

WBPMS( Shall be taken 
up in 2nd Stage) 
 

28 Final handing over of Project to 
client.  
 

Executive 
Engineer 
Field unit 

Not yet included in 

WBPMS( Shall be taken 
up in 2nd Stage) 
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2.0 Activities required in Project Monitoring System :- 
 

1. Registration of Project and Generation of Project ID:- 

All ‘Projects’ for which requisition is received, need to be registered 
in Project Monitoring System using the Project Registration Window. A 
unique project code shall be generated for each project registered which 
can be used for all future reference of the particular project. 

 
‘Project’ is a work for which Requisition has been received from a 

client department or sanction has been issued by the client department for 
execution against a capital budgetary head, deposit, etc for which a 
separate A/A & E/S has been accorded.  

 
 ‘Project Code’ is the WBPMS generated unique number for the 
registered project giving the project identification linked to Client, state of 
its location and the calendar year in which requisition received. 
 

  A project will be further divided into three tier system 

as adopted in the Web Based Project Monitoring System.  

Project 
Package 

Agreement ( Called Subwork 
before award of work) 

 

2. Monitoring the Progress of work in planning Stage using 

letter Generation at important Stages:-  

After a project is registered in WBPMS, Project Monitoring 
System requires mandatory usage of WBPMS generated letters (for 
correspondence) at important stages of project in standard formats 
(defined in Annexure-C), which would simultaneously update the 
project related information in database. 

 
Generating online letters will provide the user an easy way to 

generate the required letter at important stage of work by different 
offices which will simultaneously update the project data that shall be 
used for updating the status of work and preparation of MPR in 
required format without asking much data from the user. 

 
All offices shall be using the system every day for generation of 

letters so the status of project will keep on updating automatically 
without any extra effort so generation of letters are very essential for 
success of WBPMS.  
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3. Division of Project Packages after receipt of A/A and E/S. 

After receipt of AA and ES of the Project, the project can be 
divided into different number of packages. A package may be divided 
into different number of Sub works. A Sub works is a part of a package 
which can be converted into Contract agreement and may be awarded 
to an agency through call of tender. 

 
‘Package’ within a project is an independent component of a 

project, which is executable singly/ jointly by one or more divisions 
(Civil, Elect and/or Horticulture) and it can be made fully functional 
independently without any linkage to the other package(s). A project 
shall have at least one package. Decision on the number of packages 
within a project and the scope of work of each package is to be decided 
by the ‘project owner’. 

 
‘Sub-work/ Agreement’ is that component of a package, which is 

executable independently by one division (of civil, electrical or 
horticulture) through a single Technical Sanction/ NIT/ Agreement/ 
contractor. A package shall have at least one sub-work/ agreement. 
Decision on the number of sub-works/ agreements within a package 
and the scope of work of each sub-work/ agreement is to be decided by 
the ‘project owner’. 

 
‘Project Owner’ is that field authority (i.e. EE/ SE/ CE) 

responsible for submission of preliminary estimate for that project. 
 
Project Owner shall be responsible for Monitoring of Progress of 

all Components of a project like Packages and Sub Works irrespective 
of the Amount of separate package and Sub Works.  

 
Different divisions may be executing different component (Sub 

work or Agreement) of a project. But due to mapping of project with 
different sub works/ agreements by project owner overall expenditure 
can be monitored for a project in the system without any extra effort by 
collecting data from different offices and rearranging them for a project.  

 
Similarly the Date of Start, Date of Completion and Target date 

of Completion need to be filled up by the user for different agreements 
only. For package and project stipulated and target date of start and 
completion of the project including percentage progress will be 
calculated by the system on weighted average basis automatically.  

 
Following example is for illustration of the working of WBPMS:- 
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Example of Expenditure and Date management for Packages and projects:  

         
  AA and 

ES 
amount 

Agreement 
amount 

Date of 
Start 

St date 
of 
Comple
tion 

Target 
date of 
Comple
tion 

Upto 
date 
Expen
diture  

Percent 

progres

s 

 
1 Name of Project 

:-  
C/O Javahar 
Navodaya 
Vidyalay at Pune. 

Rs 1200 
Lakhs 

Total of 
all agrmnt 
under 
packages 

4/2009 10/2014 10/2014 Sum 
of all 
packa
ge 

Wght 
aver 
percnt 

 Package 1 School 
Building 

700 lakhs Total of 
all agr 

4/2009 8/2012 3/2013 Sum 
of all 
agr 

Wt aver 
percent 

C
iv

il 
W

o
rk

 Agreement 1 ( or 
Subwork 1) 
C/O School 
Building for JNV at 
Pune (Civil Work) 

 
600 
Lakhs 

 
586 Lakhs 

4/2009 4/2010 5/2010 100 30 % 

C
iv

il 
W

o
rk

 Agreement 2 
C/O Water Tank 
for School Building 
for JNV at Pune 
(Civil Work) 

 
50 Lakhs 

 
57 Lakhs 

5/2010 12/2010 3/2011 30 10% 

E
le

c
t 

w
o
rk

 

Agreement 3 
C/O Street lighting 
for road outside  
School Building for 
JNV at Pune (Elect 
Work) 

 
30 Lakhs 

 
32 Lakhs 

6/2010 4/2011 9/2011 20 0% 

H
o
rt

 w
o
rk

 Agreement 4  
Horticulture works 
for School building 
for JNV at Pune  
( Horticulture work) 

 
20 Lakhs 

 
23 Lakhs 

4/2011 8/2012 3/2013 10 55% 

         
 Package 2 Staff 

Residences 
500 lakhs Total  5/2010 10/2014 10/2014 Sum 

of all 
agr 

Wt av 
percent 

C
iv

il 
w

o
rk

 Agreement 1 
C/O Staff 
Residences for 
JNV at Pune (Civil 
Work) 

 
400 
Lakhs 

 
412 Lakhs 

 
5/2010 
 
 

 
10/2014 

 
10/2014 

 
212 
 
 

 
45% 

C
iv

il 
w

o
rk

 Agreement 2 
C/O Road work for 
Staff Residence for 
JNV at Pune (Civil 
Work) 

 
50 Lakhs 

 
42 Lakhs 

 
6/2010 
 

 
10/2012 
 

 
9/2012 

 
32 

 
60% 

E
le

c
t 

w
o
rk

 Agreement 3 
Electrical works for 
Staff Residence for 
JNV at Pune 
(Electrical Work) 

 
30 Lakhs 

 
33 Lakhs 

 
7/2010 

 
12/2012 

 
11/2012 

 
13 

 
30% 

Bold and underlined figures and dates shall be calculated by 
system automatically. 
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4. Linkage of Project with Divisional Accounting Package :-  

For getting started in WBPMS on project(s) by the project 
stakeholders, field units are required to perform ‘one time operation for 
a project’ involving registration of that project/ package and subworks 
and its mapping or linking with NIJ Divisional Accounting package. 
Whereas the ‘WBPMS based mandatory operations’ by field and 
planning units including its monthly update results in status update of 
projects. The sequence of these operations is described as under:- 

 
1. Projects are to be registered by field units and ‘Project Code’ 

generated, by project owners, with the data as per Annexure A.  
 

2. Packages and Subworks/ Agreements to be identified by field 
units (by project owners) with data as per Annexure B. This is to 
be done only after the ‘Project Code’ is generated.  

 
3. Mapping for each Agreements to be done in WBPMS by the 

respective Divisional Unit using ‘8 digit code taken from Nirman 
Info-Jyothi (NIJ)’ generated for each Agreements(TS Wise) and 
entered against the  each Agreeement under ‘Project Code’ 
obtained as above at Sl. 1 above on registration in WBPMS.  

 
4. Only agreements need to be mapped with divisional accounting 

package. Details of Package and Projects are automatically 
collected by programme in respect of a project from different 
divisions for getting the accumulated figure. 

 

5. Activities for Award of Work for different Sub Work :- 

Activities like Sending of Working Architectural Drawing by 
Senior Architect for Execution of work and Sending of Structural 
Drawing for Execution of work shall also be sent using Web based 
generated letters and details shall be get updated automatically. 

 
Technical Sanction and NIT shall be issued by competent 

authority for each Sub Work decided for different packages shall be 
issued using online letter generation by Web Based Project Monitoring 
System.  

 
Tender shall be called for each Sub Work using Web Based 

PMS  and letter for sending the Notice Inviting tender to Press Media 
and Internet Media Like www.tenderhome.com  shall be sent through 
PMS generated letter. These activities and important data like 
Estimated cost date of T/S, NIT date of call of tender, date of opening 
of tender will be automatically updated in the system. 

 
Tender forwarding Note shall also be generated using PMS and 

comments by higher authorities can also be sent using the system.  
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Approval of tender by competent authority shall also be 

conveyed using the system.  
 
Letter for submission of Performance Guarantee shall also be 

issued to the Construction agency using the PMS generated letter. 
 
Final Award letter to Construction agency can also be issued 

using the system. 
 

 

6. Review the Progress of Each Work Every Month and  

Periodical Monthly Update of Expenditure Data by field 

units:-  

Every Month following activities are required to be performed 
once for updating the Remarks Column, Expenditure Figure etc related 
to each project for preparation of Monthly Progress Report :-  

 
1. Update of expenditure data from Divisional Accounting 

Package up to the end of previous month by respective Divisional 

unit by uploading of NIJ accounts data periodically on 1st working 
day of following month. 

 
2. Update of ‘Current Status Remarks’ with ‘Physical Progress (in 

%)’ shall be done by field units starting from divisional unit and 
mandatorily upto the level of ‘project owners’ for each project in 
progress as under:- 

a. Update by EE on 2nd working day of month of ‘Current Status 
Remarks’ with ‘Physical Progress (in %) for all projects being 
executed by that Division. 

b. Review/ correction by SE in a circle by 3rd working day of 
each month.  

c. Accepted by the CE (with modification, if necessary) in a 
zone by 4th working day of each month. 

The correctness of ‘current status remarks’ with ‘physical progress (in 
%)’ of a project in WBPMS shall be the personal responsibility of 
‘Project Owners’.  
 
Presently Executive Engineers can fill % progress and Remarks through 
divisional accounting package and they can upload the month Divisional 
accounting data on WBPMS. In future facility shall be provided to 
Executive Engineer also for updating % progress and Remarks column 
online using WBPMS for each agreements/ projects.   
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3.0 Reports that can be generated using the System :- 

Following Reports can be generated using Project Monitoring 

System :-  

 

1. Monthly Progress  Report of CPO and NON CPO Works of 

following stages :- 

Sr 

No. 

Mothly Progress Reports  Report No.  

 CPO WORKS  

1 Requisition from client received-Unsanctioned Work 14 

2 PE sent to Client – Unsanctioned Work 13 

3 Sanctioned but not yet started 12 

4 Sanctioned and Work is in Progress 11 

5 Work Completed 10  

 NON- CPO WORKS  

1 Requisition from client received-Unsanctioned Work 18 

2 PE sent to Client – Unsanctioned Work 17 

3 Sanctioned but not yet started 16 

4 Sanctioned and Work is in Progress 15 

5 Work Completed 20 

 

2. Expenditure Card  

3. Expenditure Return 

4. Details of Works as per following  

a. State Wise 

b. Client Wise 

c. Cost of Work wise 

d. CPO/ NON CPO Works  
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ANNEXURE – A 

Web-Based PROJECT MONITORING SYSTEM                  
DATASHEET FOR REGISTRATION OF PROJECT 

 

1. Type of Project (Tick appropriately)     :  1. CPO  2. Non-CPO  

2. Name of Project       :……………………………… …………….. 

3. Location of Project 

i. State/ Union Territory   ……………………………………… 

ii. Location        :……………………………………………… 

4. Fund Sanction      :  
Sr No. Type of Fund Sanction Tick appropriately 

1 Budgetary  

2 Letter of Authorisation  

3 Deposit  

4 Cash Settlement Suspense  

5 Others  

5. Client Department Information 

1 Client Department Name 

(to be selected from the list) 

 

2 Designation of Authorised 

official of client department 

 

3 Client  Address for 

correspondence 

 

 

 

6. Status of Project  
Sr No. Type of Fund Sanction Tick appropriately 

1 Requisition from client received-Unsanctioned 

Work 

 

2 PE sent to Client – Unsanctioned Work  

3 Sanctioned but not yet started  

4 Sanctioned and Work is in Progress  

5 Work Completed  

 

7. Requisition Details (Mandatory for Status Id 1, 2, 3,  4 & 5) 

a. Date of Requisition       :  …………………………………… 

b. Requisition Letter No.      : ……………………………… 

8. Preliminary Estimate Details (Mandatory for Status Id 2, 3,  4 & 5)  

a. Forwarding Letter No.     : No. …………………………. 

b. Forwarding date      : ……………………………… 
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c. PE Amount       : Rs. ……………………… 

9. A/A&E/S details (Mandatory for Status Id 3,  4 & 5) 

a. Amount of A/A & E/S     : Rs ………………………… 

b. Sanctioning Authority      : …………………………….. 

c. Letter/ Sanction No.      : No. ………………………… 

d. Date         : ……………………………. 

e. Head of Account        : …………………………… 

f. Start Date        :…………………………....... 

g. Finish date         : ……………………………. 

h. Stipulated date of Completion     : …………………………….. 

10. Date of Actual Completion of Project     : ……………………………. 

(Mandatory for Status Id 5) 

11. Specify field units related to project execution (In case of more than one division 

is involved for the same discipline, all such divisions are to be indicated): 

DISCIPLINE ZONE DIVISION 

CIVIL Related   

ELECTRICAL Related   

HORTICULTURE Related   

12.  Specify Planning Units related to project planning (In case of more than one unit 

is involved for the same discipline, all such units are to be indicated): 

NATURE OF PLANNING ACTIVITY PLANNING UNIT NAME 

Civil Planning Unit 
(Prel Estt, Det Estt, Tech Sanction, NIT 

 

Electrical Planning Unit 

(Prel Estt, Det Estt, Tech Sanction, NIT 

 

Horticulture  Planning  
(Prel Estt, Det Estt, Tech Sanction, NIT 

 

Architectural Unit  

(Prel Drgs, Detailed Working Drgs, Local Body 

Approval) 

 

Structural Design Unit  

(Analysis and design of  structural members) 

 

 

 

 

EE(P) EE(P) SE(P) EE/ SE/ E  

(Retain designations as may be applicable) 
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ANNEXURE – B 

 

Web-Based PROJECT MONITORING SYSTEM 
DATASHEET FOR REGISTRATION OF PROJECT 

 
 

1. Project Id      :…………………………………………… 

  

2. Name of Project     :………………………………………………  

         ……………….……………………………… 

3. Package & Subwork Details 

Sl 

No 

Package 

Name 

Amount 

(As per 

PE) 

Subwork Name (To be 

converted later to T/S, 

NIT/ Agreement) 

Start Date 

 

Finish Date 

 

1   1.   

2.   

.   

   

2   1.   

2.   

.   

   

 

 

 

 

 

AE(P) EE(P) SE(P) 

(Retain designations as may be applicable) 

 

EE/ SE/ CE  

Project owner 
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Annexure – C. 

List of letters which are mandatory to be generated using 

PMS:- 

 
Letter 

No. 

Letter  Authority  Letter to be generated using Web based 

project Monitoring System  

1 Project Registration after 
getting Requisition letter 

from Client 

Project Owner 
 

Letter of Registration of project and 
generation of Project ID shall be sent 

by project owner to all offices 

concerned. 

 
2. Sending of Preliminary 

Architectural Drawing by 

Senior Architect  for 
approval from Client 

Department 

Senior Architect.  Forwarding Letter to Client 

Department.  Copy of letter to be sent 

to all offices concerned. 

3. Sending of Approved 
Preliminary Drawing by 

Senior Architect to other 

offices for preparation of 

Prel Estimates. 

Senior Architect.  Forwarding Letter for conveying the 
approval of PD and sending the 

approved Preliminary Architectural 

Drawing to other offices.  Copy of letter 

to be sent to all offices concerned. 
 

4. Sending of Preliminary 

Estimate to Client 
Department for accord of 

AA and ES. 

CE / SE(P)/ SE / 

EE  
 

Forwarding Letter for sending the 

Preliminary Estimate to Client 
Department for accord of AA and ES.  

Copy of letter to be sent to all offices 

concerned. 
 

4. Acoord of AA & ES  

received from Client 
Department to be conveyed 

to other offices for 

necessary action. 

CE / SE(P)/ SE / 

EE  
 

Forwarding Letter for conveying the 

Acoord of AA & ES  received from 
Client Department to other offices for 

necessary action.  Copy of letter to be 

sent to all offices concerned. 
 

5. Distribution of total AA and 

ES amount to different 
Package to be decided by 

the project owner 

CE / SE(P)/ SE / 

EE  
 

Forwarding Letter for conveying the 

different packages of the work with 

amount allocated to other offices for 

necessary action.  Copy of letter to be 

sent to all offices concerned. 

6. Sending of Working 
Architectural Drawing by 

Senior Architect  for 

Execution of work 

Senior Architect.  Forwarding Letter for sending the 
Working Architectural Drawing.  Copy 

of letter to be sent to all offices 

concerned. 
 

 

 

 
7. Sending of Structural Structural Forwarding Letter for sending the 
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Drawing for Execution of 

work 
Engineer/ SE(P)/ 

SE/ EE  
Structural Drawing.  Copy of letter to 

be sent to all offices concerned. 

 
8. Issue of Technical Sanction 

for different sub works of 

different packages 

CE / SE(P)/ SE / 

EE  

 

Forwarding Letter for Issue of Technical 

Sanction for different sub works of 

different packages.   

9. Issue of approved NIT for 

different sub works of 
different packages 

CE / SE(P)/ SE / 

EE  
 

Forwarding Letter for Issue of 

approved NIT for different sub works of 

different packages.   

10. (a) Call of tender  EE/ AE Forwarding letter to Press and Internet 

Media (like tenderhome .com). 

   

 (b) Receipt of tender  EE/ AE Name of all Agencies participated in 

the tender to be entered on PMS.  This 

information shall be used for 

generation of tender forwarding 

memo. 

11 Tender Forwarding Memo 

to higher office  
AE to EE  
EE to SE 

Forwarding Letter for Tender 

Forwarding Memo to higher office for 

different sub works.   

12. Comment of SE to CE 
Office for tender of CE 

Level and above. 

SE TO  CE Forwarding Letter for Comment of SE 

to CE Office along with comment for 

tender of CE Level and above for 

different sub works.   

13. Comment of CE to higher 

Office for tender of ADG 
Level and above. 

CE to ADG or 

DG or Works 
board 

Forwarding Letter for Comment of CE 

to ADG or DG or Works board along 

with comment for tender of ADG Level 

and above for different sub works.   

14. Issue of Letter of Intent  to 

lowest renderer whose 
tender has been accepted  

EE Letter of Intent  to lowest tenderer for 

submission of Performance Guarantee.  

15. Issue of Final Award Letter 

for Start of work   
EE Final Award Letter for start of work 

after submission of Performance 

Guarantee. Copy of letter to be sent to 
AE concerned. 
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Online 
Web Based Project 
Monitoring System 

 

Note: The screens shown in this help may differ from actual screens. Due 
to Improvements in the website.. 
 

The Following are the Steps for Divisional Users for Updating Web Based 

Project Monitoring System: 
 

1) Open internet explorer (with Internet Connection) 

 

2) Please enter the above Address in the address bar 
 

Address: http://www.cpwd.gov.in and then click Project Monitoring 

System or http://www.cpwdpms.gov.in 
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Click CPWD Users 

 

 
 

3) Enter the PIMS ID and PIMS Password and click Submit. 
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4) You will get a Updation Required screen 

 
Note: On the left side of the screen you can find the menu, which 

you can click, any time with out using back button. 
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5) To Link the NIJ Codes to Subwork of WBPMS  

 
6) Click on Add Subwork (If Subwork is not added earlier) or Edit 

Subwork (if Subwork is already added) 

 

For example Select Add Subwork 
 

 
 

Select the Criteria By Particulars then click on SEARCH 
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7) Click each Project Code link (link means Project Code with 
underline) 

 

For Example when you click the Project Code CE/GO/2009/19  
 

 
 

You get the following screen. Click on NEW and then select the Pkg 

Code - Description from the screen as shown below. 
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It shows list of Subworks already added (if any). 
 

Enter the Name of Subwork, Start Date, Finish Date, Probable Date of 

Completion, Remarks, TS Amount, Agreement Amount, Physical 
Progress % and Agency Name  

 

Then Enter 8-digit code generated in Divisional Information System 
(Accounts Software – New Nirman Info Jyothi 2010) (NIJ TS Code) 

and then click “SAVE”. 
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NIJ TS 8 DIGIT ACCOUNT CODE 

 
To get the 8-digit code follow the steps as shown below 

(If your division does not maintain the accounts then contact the 

division which compiles your account 
 

8) To Search for the 8-digit code generated in Divisional Information 

System (New Nirman Info Jyothi 2010): 

 

a) Open “Open” 
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Enter the User Name and Password and click Enter 

 

Select the Current Financial Year 

 

Select Division and Financial Year and Click Next 
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b) Select Master Details > Project Menu > Refer > Name of 

the Client 

 

 

c) Select the Client by double clicking it. 
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d) List of Projects will be displayed. Note the 8-digit code for the 

Name of work and Subwork/T.S./Agreement 

e) If Name of work and Agreement does not exist in the list then 

take the help of Accounts Branch people to register the work. 

For New Project Registration Please follow the steps given 

below 

Click on Add -> New Project 
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Then Save the Project and Note the Number (The First Agreement 

will have 0001 along with the Project Code i.e., 13280001 for the 

above Agreement) 
 

If there are more number of Agreements in the same project then 

follow the procedure as shown below: 
 

Click Add-> New Tech.Sanc.for Existing Project -> Search By -> 

Project 
 

 
 

  



 
PROJECT MONITORING SYSTEM                                                    O/o CE, CDO, CPWD, NEW DELHI 

Info Jyothi Software Consultancy, Chennai Page 32  
 

 
 

Select the Project Under which you want to add another Agreement 
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Or 

 
Open Form 64 For  Budgetory/Authorisation/CSS Heads of 

Account and Form 65 TS Wise for Deposit Works 

Eg: 10010001, 10010002  

 
First 4 digits represents the NIJ Project Code and the 

remaining 4 digits represents the NIJ TS Code 

(Subwork/TS/Agreement) 
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Entering the 8-digit code in the website against the Subwork 

 (This is called mapping/linking) 
 

9) Follow the above steps for all the works wherever mapping/linking 

is required. 

 
10) After all the above tasks use “Export System” (Module in NIJ 

Accounts Software) for generation of zip file. The generated file can 

be found in “C:\Avkr\ExportData”. Example: 
K04W1H111231052011.ZIP 

 
a) Select the Month (Month Name Shown along with Number) 

b) Click on Division Code 
c) Then select the Financial Year and Then Click Generate PMS File 
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Click on Yes for Confirm Compilation of Accounts for the repective 

month and financial year. 
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11) Upload the file generated to the server through website. 

 
a) Click on Monthly Update  

 

 
 

b) Click on PMS File (ExportData) 

 
 

c) Click on Browse 
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d) Then Select the file from “C:\Avkr\ExportData” 

 

 
e) Then Click UPLOAD ZIP. 
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f) You will receive the message “Division File Uploaded 

Successfully” 

 
 

g) Then Click on CLICK PMS-MERGER 
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h) Take PMS File Receipt Status Report for confirmation 
 

i) Click on Alerts -> Accounts Upload Status  and then click 

Show Report 

 

 
 

 

12) Take your Monthly Progress Reports. 
 

 
 



 
PROJECT MONITORING SYSTEM                                                    O/o CE, CDO, CPWD, NEW DELHI 

Info Jyothi Software Consultancy, Chennai Page 40  
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Note: In Project Wise Progress Reports you will find only the remarks 
given by the Project Owner only. 
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INSTALLATION GUIDE  
FOR NIJ DIVISIONAL ACCOUNTING SYSTEM 
 

New Nirman Info Jyothi 2010  
 
1) Divisional Information System 

2) Divisional Accounting System 
3) Works Monitoring System 
4) Export System  

 
Read Throughly and Follow the following instructions to install the New 
Nirman Info Jyothi 2010  (Compulsory) 

Before installation you should have the following  
 The screen resolution should be 800 x 600 pixels 
 Create a directory (folder) " Avkr " in the " C:\ " 

 Operating System should be Windows based (Windows 98 and 
Above) 

 

1) Divisional Information System 
 
 In the CD (Compact Disc) there is directory (folder) named “NNIJ-

2010” 
 

 In this directory double click (Open the directory (folder) i.e., 
Explore) the          " DISSETUP “, when you explore the directory you 
can view a setup file named  " Setup " click or double click on it 

 
 When you click the setup file, welcome screen appears with a dialog 

box just click on the " OK " button 

 
 When you click the " OK " button  
 

 Click on the " Change Directory " button 
 
 It asks for the change of directory (folder) in which it should be 

loaded. You type the following in the path " C:\Avkr\NDIS2010 "
 and click " OK " button 

 

 It says directory (folder) does not exists, do you want to create it 
say yes. Now click on the button with computer icon on it. 

 In The Program Group type this “New Nirman Info Jyothi 2010” 
   

 Click on the " Continue " Button, and then click O.K. 

2) Divisional Accounting System  
 
 In the CD (Compact Disc) there is directory (folder) named “NNIJ-

2010” 
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 In this directory double click (Open the directory (folder) i.e., 

Explore) the “ DASSETUP ”, when you explore the directory you can 
view a setup file named  " Setup " click on the file 

 
 When you click the setup file, welcome screen appears with a dialog 

box just click on the " OK " button 
 

 Click on the " Change Directory " button 
 

 It asks for the change of directory (folder) in which it should be 
loaded. You type the following in the path " C:\Avkr\NDAS2010 " 
and click " OK " button 

 
 It says directory (folder) does not exists, do you want to create it 

say yes. Now click on the button with computer icon on it. 

 
 In The Program Group type this “New Nirman Info Jyothi 2010” 
 

 Click on the " Continue " Button, and then click O.K. 
 
3) Works Monitoring System 

 
 In the CD (Compact Disc) there is directory (folder) named “NNIJ-

2010” 
 

 In this directory double click (Open the directory (folder) i.e., 

Explore) the          " WMSSETUP “, when you explore the directory 
you can view a setup file named  " Setup " click or double click on it 

 

 When you click the setup file, welcome screen appears with a dialog 
box just click on the " OK " button 

 

 When you click the " OK " button  
 
 Click on the " Change Directory " button 

 
 It asks for the change of directory (folder) in which it should be 

loaded. You type the following in the path " C:\Avkr\NWMS2010 "

 and click " OK " button 
 It says directory (folder) does not exists, do you want to create it 

say yes. Now click on the button with computer icon on it. 

 In The Program Group type this “New Nirman Info Jyothi 2010” 
   

 Click on the " Continue " Button, and then click O.K. 
 
4) Export System   
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 In the CD (Compact Disc) there is directory (folder) named “NNIJ-
2010” 

 
 In this directory double click (Open the directory (folder) i.e., 

Explore) the          " EXPSETUP “, when you explore the directory you 
can view a setup file named  " Setup " click or double click on it 

 

 When you click the setup file, welcome screen appears with a dialog 
box just click on the " OK " button 

 When you click the " OK " button  

 Click on the " Change Directory " button 
 
 It asks for the change of directory (folder) in which it should be 

loaded. You type the following in the path " C:\Avkr\NEXP2010 "
 and click " OK " button 

 

 It says directory (folder) does not exists, do you want to create it 
say yes. Now click on the button with computer icon on it. 

 In The Program Group type this “New Nirman Info Jyothi 2010” 
   

 Click on the " Continue " Button, and then click O.K. 
 

PASSWORD’s 
 

Divisional Information System  
USERNAME : AVKR 
PASSWORD : DIVISION CODE 

 
Divisional Accounting System 
USERNAME : AVKR 

PASSWORD : DIVISION CODE 
 
Works Monitoring System 

USERNAME : AVKR 
PASSWORD : DIVISION CODE 
 

Export System 
NO PASSWORD 
 

NOTE:  
 

1) If you get any Version conflict message please click on No to All. 

2) If you get any Error message click ignore  
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For Help Contact 

 
Kishore 

Software Engineer 
Old.No.148/8, New No.28, I Floor, 

Habibullah Road, T.Nagar, 

Chennai – 600017 
Email: ijsoftware@yahoo.co.in 

09282232157 (Chennai) 

 
     Kishore 

Software Engineer 
No.92B/5, Room No.20, III Floor, 

Munirkha Village, 

New Delhi – 110067 
Email: nij_software@yahoo.co.in 

09958001055 (Delhi) 

mailto:ijsoftware@yahoo.co.in
mailto:nij_software@yahoo.co.in

